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THANK YOU FOR CHOOSING ROSS VIDEO
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support
2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
david.ross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:
1. We will always act in our customers’ best interest.
2. We will do our best to understand our customers’ requirements.
3. We will not ship crap.
4. We will be great to work with.
5. We will do something extra for our customers, as an apology, when something big goes wrong and 

it's our fault.
6. We will keep our promises.
7. We will treat the competition with respect.
8. We will cooperate with and help other friendly companies.
9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 

times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)

About this Guide
• Ross Part Number: 7800DR-016-10.3
• Release Date: June 27, 2025. Printed in Canada.
• Software Issue: 10.3

The information contained in this Guide is subject to change without notice or obligation.
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© 2014 - 2025 Ross Video Limited. Ross® and any related marks are trademarks or registered trademarks of Ross 
Video Limited. All other trademarks are the property of their respective companies. PATENTS ISSUED and 
PENDING. All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or 
transmitted in any form or by any means, mechanical, photocopying, recording or otherwise, without the prior 
written permission of Ross Video. While every precaution has been taken in the preparation of this document, Ross 
Video assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting 
from the use of the information contained herein.

Patents
Patent numbers 4,205,346; 5,115,314; 5,280,346; 5,561,404; 7,034,886; 7,508,455; 7,602,446; 7,834,886; 
7,914,332; 8307284, 2039277; 1237518; 1127289 and other patents pending.

Warranty and Repair Policy
Ross Video Limited (Ross) warrants its Streamline Pro Server systems to be free from defects under normal use and 
service a time period of 15 months from the date of shipment:

If an item becomes defective within the warranty period Ross will repair or replace the defective item, as 
determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the 
customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, 
plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo 
repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or 
unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, 
are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

Extended Warranty
For customers that require a longer warranty period, Ross offers an extended warranty plan to extend the standard 
warranty period by one year increments. For more information about an extended warranty for your Streamline Pro 
Server system, contact your regional sales manager.



Environmental Information
The equipment that you purchased required the extraction and use of natural resources for its production. It may 
contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration. You can also contact Ross Video for more information on the environmental performances of 
our products.

Use of Hazardous Substances in Electrical and Electronic 
Products (China RoHS)
Ross Video Limited has reviewed all components and processes for compliance to:

“Management Methods for the Restriction of the Use of Hazardous Substances in Electrical and Electronic 
Products” also known as China RoHS.

The “Environmentally Friendly Use Period” (EFUP) and Hazardous Substance Tables have been established for all 
products. We are currently updating all of our Product Manuals.

The Hazardous substances tables are available on our website at:

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

电器电子产品中有害物质的使用 

Ross Video Limited 按照以下的标准对所有组件和流程进行了审查： 

“电器电子产品有害物质限制使用管理办法”也被称为中国RoHS。 

所有产品都具有“环保使用期限”(EFUP）和有害物质表。目前，我们正在更新我们所有的产品手册。 

有害物质表在我们的网站： 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html 

http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html
http://www.rossvideo.com/about-ross/company-profile/green-practices/china-rohs.html


Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613.652.4886
Fax: (+1) 613.652.4425

Technical Support: (+1) 613.652.4886
After Hours Emergency: (+1) 613.349.0006

Email (Technical Support): techsupport@rossvideo.com
Email (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Introduction
A Word of Thanks
Thank you for choosing Ross Video Xchange Suite as your media asset management solution.

We are committed to providing you with the highest level of customer satisfaction possible. If, for any reason, you 
have questions or comments, please call Ross Video at +1-613-652-4886 or send us an e-mail at 
techsupport@rossvideo.com.

We hope that you visit our website www.rossvideo.com to stay up to date with ongoing software releases, join our 
customer forum and learn more about the complete range of Ross Video products.

Note that software maintenance and extended warranties are available for your system to protect and extend the life 
of your investment. Our sales team is more than happy to provide further information on the plans available. 
Members of our sales team will promptly response to e-mails sent to: solutions@rossvideo.com.

Again, thank you for your purchase of a Xchange Suite media asset management solution from Ross Video. We are 
confident of your future pleasure with your choice.

Yours Sincerely,

Alan Dabul
Product Manager - MAM + Storage
adabul@rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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About This Guide
This guide contains the following chapters that cover the use of the Xchange Suite:

1. Introduction — summarizes the guide and provides important terms, and conventions.

2. Exploring the Streamline Xchange User Interface — summarizes the main screens and panels of the 
Xchange Suite user interface.

3. Streamline Xchange Workspace — describes how to configure a workspace to meet your workflow 
requirements.

4. Streamline Xchange Upload Manager — describes how to upload media files to Xchange.

5. Editing Metadata in Streamline Xchange — describes how to edit metadata information attached to assets.

6. Searching for Assets in Streamline Xchange — describes how to search for assets.

7. Markers and Subclips — describes how to create and manage markers and subclips.

8. Attaching Associated Files — describes how to attach files to assets and manage the attached files.

9. Streamline Xchange Library — describes how to work with folders in the Xchange Library.

10. System Monitor — describes how to use the System Monitor screen to monitor the status Xchange.

11. Project Dashboard — describes how to use the System Monitor to Project Dashboard screen to view the 
project activity in Xchange and manage projects.

12. Adding Users and Groups — describes how to add users and groups to your Xchange system.

13. Smart Bins — describes how to add Smart bins to your Xchange system.

14. Metadata and Forms — describes how to add metadata and forms to your Xchange system.

If you have questions pertaining to the operation of Xchange Suite, please contact us at the numbers listed in the 
section ““Contacting Technical Support” on page 1–3”. Our technical staff is always available for consultation, 
training, or service.

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Assets panel, click Delete.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the section “Managing Large Projects” in the Xchange Suite MAM Panel User 
Guide.
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Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 After upgrading Xchange Suite software, you must obtain feature licenses from Ross Video Technical Support 
before users can access Xchange Suite features.

Contacting Technical Support
Technical Support is staffed by a team of experienced specialists ready to assist you with any question or technical 
issue.

Ross Video has technical support specialists strategically located around the globe to ensure a prompt response to 
technical inquiries. Our primary technical support center is located in Ottawa, Ontario, Canada. In addition, we 
have offices in The United Kingdom (London), Australia (Sydney), and Singapore with satellite locations in New 
York City, The Netherlands, and China. As we expand our presence globally, we are constantly evaluating other key 
locations to have a local technical support specialist in order to better service our customers.

North America

Our North America center located in Ottawa, Ontario, Canada and is open Monday to Friday 8:30 a.m. to 6:00 p.m. 
EST, with 24/7/365 on-call service after hours.

Our telephone number is: +1-613-686-1557

Toll free within North America: +1 844-652-0645

EMEA

Our EMEA center is open Monday to Friday 8:30 a.m. to 5:00 p.m. GMT. After hours support is provided by our 
North America location.

Our telephone number is: +44 (0)1189502446

International toll free: +800 3540 3545

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Australia

Our Sydney, Australia office is located in Alexandria, NSW.

Our local support telephone number is: 1300 007 677

If the local support specialist is not available, your call will be transferred automatically to our North America 
center.

Online

E-mail: techsupport@rossvideo.com 

Website: open a support request using the link http://www.rossvideo.com/support/tech-support.html to open a 
support request.

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com/support/tech-support.html
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Getting Started
Streamline Xchange Suite is a Web-based platform to store, share, edit, review, approve, archive, and prepare your 
footage from anywhere. The metadata-driven application features a comment, rating and media activity tracking 
system for finding the assets you need, when you need them. Additional functionality includes the ability to create 
markers and subclips with embedded metadata for use later in the production.

This chapter discusses the following topics:

• Start Streamline Xchange
• Exploring the Streamline Xchange User Interface
• Streamline Xchange Media Player
• Streamline Xchange Results Panels
• Xchange Media Manager Actions
• Streamline Xchange Media Details Panel
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Start Streamline Xchange
Streamline Xchange user-rights and permissions determine what a user can and cannot do. Permissions are based on 
users and groups, which have been pre-established with management during system configuration.

Figure 2.1  Login Screen

• Login — use an HTML5 web browsers to open the Streamline Xchange web page provided 
by your Streamline Xchange administrator and log in.
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Exploring the Streamline Xchange User Interface

Figure 2.2  Main Screen

1) Xplore — this option brings the User to the Main Screen of Streamline Xchange (as shown 
above)

2) Workspace — facilitates the customization of Workspaces node is used to Add, Edit, Delete, 
Copy, Set as Default, and Hide/Show additional workspaces.

3) Upload Manager — facilitates the ingest of media with tagging functionality.
4) System Monitor — displays activity within Streamline Xchange.
5) Project Dashboard — displays activity of the projects, is used to see, add, edit or Delete 

projects.
6) Multiview — this option allows the user to select from the list of sources, toggle advanced text, 

select from the number of players, and mute audio.
7) Configs — facilitates the configuration of the system.
8) Video Editor — click this tab to open the Streamline Pro Web Video Editor. 

 This tab is only available for systems that purchase the Streamline Pro Video 
Editor license.

9) Logout — log off to Streamline Xchange system. 
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Main Toolbar

Figure 2.3  Browse Tab

1) SEARCH — searches through name, description and record ID.
2) ADVANCED SEARCH — clicking the Filter icon next to Search reveals in-depth search 

categories.
3) LIBRARY — the content database.
4) MY MEDIA — these bins receive all assets uploaded by the current logged-in user. My Media is 

accessible through the Streamline Xchange Panel for Adobe Premiere, enabling editors to 
access and edit from its media. Additional bins can be created in the Library; then anything 
uploaded goes into My Media and can be dragged and dropped into other libraries.

5) SMART BINS — contain pre-defined search queries. Smart bins are created and managed at an 
administration level. If a group has permission to see a smart bin, the bin will appear the same to 
that group and all other groups with the same access. Under categories all the different 
“Customers” can be found.

6) PROJECTS — organizational collections of media that users can view and share. Media can be 
added by uploading or dragging and dropping existing media into the project.

7) ROUGH CUTS — use the rough cut area to create a sequence of video and audio clips that you 
wish to perform basic edits — such as trimming, clip selection, and organization of the clips — in 
the timeline editor before the final sequence is ready. 

3

5

4

6

21
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Menu Sidebar Tools Tab

Figure 2.4  Tools Tab

1) BATCH METADATA EDIT — If clips have common characteristics or need to be retrieved as a 
group, they need the same metadata. BATCH METADATA EDIT allows multiple clips to receive 
the same metadata simultaneously.

2) ACTIONS — represent automated scripted events to be performed on highlighted media or 
projects.

3) MEDIA TOOLS — additional functions including deletion of assets.
4) WORKFLOWS — select the script (configured on the Workflow Server) to be executed.

1

2

3

4
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Streamline Xchange Media Player
The Streamline Xchange Media Player enables users to playback media. Within the player, users can create markers 
and subclips that become part of the media file. They are accessible to other users who call the clip up in Streamline 
Xchange or work with it in an Adobe Premiere Pro environment.

Figure 2.5  Video Player Screen

1) Timecode — Streamline Xchange inherits timecode from the original material.
2) Marker — a Marker is a reference point made at a specific point in time. After it is set, it can be 

named and given a description. This information will move with the clip for communication with 
the editor.

3) Subclip Creation — use the following buttons to create subclips:
• { — Mark In
• } — Mark Out
• S — after using Mark In and Mark Out to define the area, S creates the subclip and displays it 

in the media details panel at right.
4) Player Controls — from left to right the controls are as follows: 

• One Frame Back 
• Play 
• One Frame Forward 
Streamline Xchange keyboard shortcut equivalents:
• J — backwards play. The play speed varies depending on how many times the key is pressed.
• K — pause
• L — forward play The play speed varies depending on how many times the key is pressed.

5) Full Screen — allows for full screen playback from Xchange monitor.
6) Master Volume — adjustment of playback volume for media loaded into the Xplore monitor.
7) Audio Wave Form — allows monitoring of discreet audio channels on clips loaded into the        

Streamline Xchange Monitor. 
8) Media Quality — change the playback resolution here. This affects any clips loaded into the 

monitor until the setting is revised. For the best quality, select the highest setting the current 
bandwidth can tolerate.

7

5 61 43
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8
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Streamline Xchange Results Panels
Just below the Streamline Xchange Media Player are clips representing either search results or assets inside of a 
highlighted bin or smart bin.

Figure 2.6  Streamline Xchange Results Panel

Xchange Media Manager Actions
The Streamline Xchange Media Manager has the actions available to manage the media assets within the projects or 
the media without an associated project.

Figure 2.7  Media Manager Panel

1) Multiple Clip Selection — clicking this button alerts Streamline Xchange that multiple clips are 
about to be selected.

2) Sort By — clips in the MEDIA PANEL can be sorted by a variety of categories.
3) Screen Layouts — each button represents a different Streamline Xchange layout based on 

priorities users need with certain functions.

1 2 3
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The following actions are available in the Streamline Xchange Media Manager:

• Create Placeholder 
• Remove Media From Bin — only available when the media asset is associated with a project.
• Create Versioned Group 
• Ungroup Versioned Media 

Create Placeholder
The Create Placeholder action creates an asset within the system with no files or media available. Usually used for 
situations where information or metadata is needed before the media or file is available within the system.

To create a placeholder

1. In the Menu Sidebar, click th e Browse tab.

The Browse tab opens.

2. In the PROJECTS section of the Browse tab, select the Project and the Bin where you want to create a 
placeholder.

3. In the Media Manager, click Actions and then select Create Placeholder.

The Create Placeholder dialog box opens.

Forms and necessary information are personalized by the client.

4. In the Name box, enter a name for the placeholder.

5. Use the Server list to select the server on which to create the placeholder.

6. In the Metadata section, enter the necessary metadata for the placeholder.

7. Click Create.

The Media Manager, displays the new placeholder.
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Streamline Xchange Media Details Panel
The Media Details panel reacts to the asset highlighted in the Results Panel. When an asset is selected in the Results 
panel, the Info tab displays metadata associated with the selected asset. The Info tab also contains a section to enter 
additional metadata for the selected asset.

Figure 2.8  Media Details Panel

META+ Tab
When you select an asset the META+ tab opens to display the embedded and not editable metadata associated with 
the selected asset.

Figure 2.9  Media Details Panel META+ Tab

ANNOTATE
The ANNOTATE tab contains the following tabs:

• MARKERS — displays the timeline markers set for the selected asset.
• SUBCLIPS — displays the subclips defined in the selected asset.
• CAPTIONS — enables the addition of captions to the selected asset.

Figure 2.10  Media Details Panel ANNOTATE Tab
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Info Tab Media Buttons
The Media Details panel Info tab contains the following row of buttons displayed below the asset image that you 
can use to manage the selected asset:

•  Download — Field users retrieve assets from storage through Streamline Xchange. Users select quality and 
location and the asset is retrieved. 

•  Refresh — updates media in the monitor.

•  Sync Media — synchronizes metadata, markers and subclips 

•  Download Link — provides a link for outside users to view media. Use caution as it is connecting outsiders 
to shared storage.
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Streamline Xchange Workspace
The Xchange Workspace screen enables users to configure a workspace to meet their workflow requirements. Users 
must have permission to create workspaces to be able to configure them.

This chapter discusses the following topic:

• Create and Configure a Workspace
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Create and Configure a Workspace
Users must have permission to create workspaces to be able to configure them.

To create and configure a workspace

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. From the main menubar, click Workspace.

The Workspaces screen opens

5. In the top right corner of the Workspaces screen, click the Edit Workspace slider to move it to the right.

The Add Component selection opens.

6. In the Add Component section, use the Tile Type list to select the type of tile to add to your workspace.
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7. After selecting the type of tile to add, click CREATE TILE.

A new tile of the selected tile type opens in your workspace.

8. To position the tile in your workspace, click and drag the tile to the required position in the workspace.

9. To resize the tile, click and drag any border or corner of the tile.

10. Use the following tools to manage a tile:

•  Delete — delete the tile from the workspace.

•  Edit — edit the tile type and styling.

11. Repeat steps 6 to 10 to add and position the tiles that you require in your workspace.

12. After completing your workspace, use the Layout menu to select Save as New Workspace.

The Layout menu also contains the following commands:

• New — create a new workspace layout.
• Open — open a saved workspace layout.
• Clear — delete all tiles from the open workspace.
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Streamline Xchange Upload 
Manager
The Streamline Xchange Upload Manager accesses external resources to copy media from the original locations 
into Streamline Xchange. Prior to uploading, Streamline Xchange presents forms that offer fields to input metadata 
to be attached to the clips. Forms customized for specific cases narrow down the metadata fields to those that apply 
to a specific circumstance. If there are categories of metadata on more than one form, multiple forms can be filled 
out prior to upload. Any metadata input on a form is automatically attached to media being uploaded.

This chapter discusses the following topics:

• Upload Media to Streamline Xchange
• Metadata Forms
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Upload Media to Streamline Xchange
The Upload Manager enables you to accesses external resources to copy media from the original locations into 
Streamline Xchange. You can also attach metadata to the media that you upload to Streamline Xchange.

To upload media to Streamline Xchange

1. Use an HTML5 web browsers to open the Streamline Xchange web page provided by your Streamline 
Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Streamline Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Streamline Xchange opens.

4. From the main menubar, click Upload.

The Upload Manager screen opens

5. Use one of the following methods to add the media to upload to the upload list:

• Drag & Drop — drag one or more media files from a storage location into the Drag & Drop Files area.
• Browse — click Browse in the Drag & Drop Files area to use a file browser to select the media files to 

upload.

6. Use the Projects list to select the Streamline Xchange project to receive uploaded media.

The Project Bins dialog box opens.

7. Navigate to the bin to receive uploaded media.

8. Click Close.

The Project Bins dialog box closes.
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9. Use the right hand panel of the Upload Manager to enter the required and optional metadata for the media 
files loaded in the upload list for ingest. Required metadata fields in a form are marked with * (asterisk).

The organization’s Ingest Form opens by default. The entered metadata is attached to all clips ingested from the 
upload list. You can change the metadata associated with individual clips after they are stored in Streamline 
Xchange.

 Streamline Xchange will not let you upload media files without entering information the required metadata for 
the files.

10. In the Drag & Drop Files area, click Upload.

Streamline Xchange ingests the media files from the upload list and associates the entered metadata with each 
ingested clip.

Metadata Forms
Streamline Xchange Metadata forms facilitate customized metadata input. Your organization can utilize several 
forms that define specific metadata to be used for certain departments or functions. Many forms can be used to tag 
or assign metadata to an asset. An asset will receive the latest metadata entered in any fields of any form attached to 
it.

Figure 4.1  Example Metadata Form
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Editing Metadata in Streamline 
Xchange
Metadata is information that makes up the core of searchable attributes in a media asset management system like 
Streamline Xchange. Some metadata is created when the a media file is ingested or a clip is created. Additional 
metadata can be attached to the assets stored in Streamline Xchange. You can also edit or delete the metadata 
attached to assets. Streamline Xchange uses forms to categorize metadata based on functionality.

This chapter discusses the following topic:

• Single Asset Metadata Editing
• Multiple Asset Metadata Editing
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Single Asset Metadata Editing
It is best to edit assets one at a time when the metadata you are editing is specific to individual assets.

To edit the metadata attached to a single asset

1. Use an HTML5 web browsers to open the Streamline Xchange web page provided by your Streamline 
Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Streamline Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Streamline Xchange opens.

4. In the Results panel, select the asset for which to edit metadata.

5. In the top right panel, click the INFO tab.

The INFO tab opens.

6. In the INFO tab, click the DETAILS tab.

The DETAILS tab opens displaying a thumbnail of the selected asset. The section below the thumbnail 
contains options to select the FORM, enter metadata information, or edit metadata information.

7. Use the list at the top of the section to select the form to use to edit metadata information.

Each form contains specific set of fields to attach information to an asset. Forms are available for several 
different organizational circumstances. Your Streamline Xchange administrator can build new forms and edit 
existing forms.

8. Edit the metadata information contained fields of the selected form.

Streamline Xchange automatically saves the metadata information that you enter.
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Multiple Asset Metadata Editing
When multiple assets require the same metadata information you can edit all of the assets at one time.

To edit the metadata attached to multiple assets

1. In the Results panel, select two or more assets that you want to attach the same metadata information.

2. In the Menu Sidebar, click the TOOLS tab.

The TOOLS tab opens.

3. In the BATCH METADATA EDIT section, use the Select Form list to select the form to enter metadata 
information for the selected assets.

The selected form opens.

4. Edit the metadata information contained fields of the selected form.

5. Click Send.

Streamline Xchange sends the entered metadata information to all of the selected assets.
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6. The ACTIONS section contains a list of automated scripted events that you can select to performed on 
selected assets or projects. If appropriate, select an action to run on your selected assets.

7. In the META TOOLS section you can click Create CSV to export the metadata attached to the selected assets 
to a Comma Separated Values (.csv) file. You can open the exported .csv file in a spreadsheet application.

Depending on your user privileges, you can also use the following tools in the META TOOLS section:

• Delete Media — delete the selected assets from Streamline Xchange.
• Re-Render Media — re-render the selected assets.
• Send to Transcode — transcode the selected assets into another media format.
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Searching for Assets in Streamline 
Xchange
Media, assets, clips, and materials are all terms used for the assets managed in Streamline Xchange. Metadata is the 
core to finding and organizing assets in Streamline Xchange. Searching and rearranging contents depends on 
efficient metadata input.

Searching assets requires knowing one piece of metadata that is attached to an asset. With just one piece of 
information you can retrieve many assets. With more pieces of information you can narrow your results down to the 
assets your require. With exact information you can find an asset or group of assets with a single search. 

This chapter discusses the following topic:

• Simple Searches
• Advanced Searches
• Recent Searches
• Favorite Searches
• Media Retrieval
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Simple Searches
Simple searches search by asset name, description, date, or record ID. A simple search will display any assets that 
match the search entry, so any instance of these categories will produce results. Simple searches can be configured 
to search up to ten additional attributes.

Searches only match exact keywords, so it is recommended to use short search queries and to avoid using spaces 
with multiple keywords. For example, search for “beach” or “2024”, but not “beach 2024” to retrieve an asset 
named “cancun_beach_July2024”. Keyword separators that are supported include commas and semi-colons, and 
these can be used in place of spaces.

 NOTE: Searches for dates will only match date field attributes, and will not match dates or numbers included in 
the asset name or other metadata. Simple searches by date have been enhanced to return date formats, but to 
ignore string text (even if the string text includes numbers). Numbered assets, such as 'asset-01032024', are not 
flagged as a date in Streamline Xchange v10.0.6 and later.

To use a simple search to find assets

1. Use an HTML5 web browsers to open the Streamline Xchange web page provided by your Streamline 
Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Streamline Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Streamline Xchange opens.

4. In the Menu Sidebar, click the BROWSE tab.

The BROWSE tab opens, which contains the SEARCH section. 

5. In the Search box, enter a word or part of a word contained in the name, description, or record ID of the assets 
to retrieve.

The Results panel displays the assets with names, descriptions, or record IDs that match the entered search.
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Advanced Searches
Advanced searches include parameters and filters that enable you to define more specific and detailed searches.

To define an advanced search

1. In the Search section of the BROWSE tab, click the  Filter icon.

The Parameters section opens.

2. To select the start of a registration date range that retrieved assets must match, complete the following steps:

a. Click in the Start Date box to open the Calendar tool.

b. In the Date selector, click the start date.

The Date selector shows the current month. To view the calendar for a different month, click the Arrows 
on either side of the month name.

3. To select the end of a registration date range that retrieved assets must match, complete the following steps:

a. Click in the End Date box to open the Calendar tool.

b. In the Date selector, click the end date.

If you do not set an end date, the search will use a date range that starts at the set start date and ends on the 
current date. The end date cannot be the same as the set start date.

4. In the Category filter, select the check boxes associated with the categories that assets must be part of to be 
retrieved. Clear all of the category check boxes to retrieve assets from all categories.

5. Expand the Options filter.

6. In the Options filter, select the check boxes associated with the options that assets must have to be retrieved. 
Clear all of the options check boxes to retrieve assets with all options.
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7. Filters enable you to define specific characteristics to narrow your search results. Click Add Filter.

The Filter section opens for you to define a filter for your search.

8. After defining parameters and filters for you search, click Search.

The Results panel displays the assets that match your defined search.

Recent Searches
After running one or more searches, Streamline Xchange temporally saves your run as suggestions for your future 
searches.

To run recent searches

1. Use the Search section in the BROWSE tab to run some asset searches.

2. Click in the Search box.

Streamline Xchange display a list of your recently run searches.

3. Select a search from the Recent Searches list to re-run the search.

The Results panel displays the assets that match the selected search.

4. To remove a recent search from the Recent Searches list, complete the following steps:

a. Click the  Remove icon to the right of the recent search to remove.

An Alert opens.

b. Click Ok.

Streamline Xchange removes the selected recent search from Recent Searches list.
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Favorite Searches
You can save often used searches as favorites searches to make them always available. Favorite searches can be 
saved when you create a search or from your recent searches.

To make a favorite out of a new search

1. Use the Search section in the BROWSE tab to define and run a new search.

The Results panel displays the assets that match your new search.

2. In the Search box, click the Favorite  icon.

The Name Favorite Search dialog box opens.

3. In the Name box, enter a name for the new favorite search.

4. Click Create.

Streamline Xchange adds the new favorite search to the Favorite Searches list.

Save Recent Searches to Favorites
Streamline Xchange only saves recent searches temporarily. You can permanently save any search displayed in the 
Recent Searches list as a favorite search.

To save a recent search as a favorite search

1. Click in the Search box.

Streamline Xchange displays your Recent Searches list.

2. Click the Favorite  icon to the right of the recent search to save as a favorite search.

Streamline Xchange saves the selected recent search as a favorite search and adds it to the Favorite Searches 
list.
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Manage Favorite Searches
After you build up a library of favorite searches, you may want to rename or delete some of your searches.

1. To rename a search, complete the following steps:

a. Click in the Search box.

Streamline Xchange displays your Favorite Searches list.

b. Click the Rename  icon to the right of the favorite search to rename.

The Name Favorite Search dialog box opens.

c. In the Name box, enter a new name for the selected favorite search.

d. Click Create.

2. To delete a search from the Favorite Searches list, click the Favorite  icon to the right of the favorite 
search to delete. You can also complete the following steps to delete a favorite search:

a. Click the  Remove icon to the right of the favorite search to delete.

An Alert opens.

b. Click Ok.

Streamline Xchange deletes the selected search from Favorites Searches list.

Media Retrieval
Registered media is usually sent to specific your company projects and bins. Using any search method retrieves 
media from all that is registered into Streamline Xchange, including media residing in a specific Project or Bin.

Any media registered by an individual also “lives” in My Media and can be copied to any other location. The asset, 
database record, never moves. Assets always copy. Copying an asset does not duplicate media on the file system.

Moving and Copying Media
Drag and drop moves or copies media from one location to another. Media can live in many different folders or bins 
simultaneously. There is always one high-res and proxy asset that Streamline Xchange points to and from any or 
many locations.

 Only users with the appropriate permission level can delete media from Streamline Xchange.
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To move or copy media

1. Use a search or open a project to list the assets to move or copy in the Results panel.

The Results panel displays the retrieved assets.

2. In the Projects section, use the tree view to select the Bin to which to move or copy assets.

3. Click and drag assets from the Results panel to their new Bin in the Projects section, then release the mouse 
button.

The Copy or Move dialog box opens.

4. Click Move to move the selected assets to the new location or Copy to copy the assets.

The Copy or Move dialog box closes and the selected assets move or copy to their new location
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Markers and Subclips
Markers enable you to add information to points along the timeline of an asset. Subclips identify smaller segments 
of an asset without replicating media.

 Deleting the asset that a subclip references removes the subclip content and renders the subclip empty.

This chapter discusses the following topic:

• Searching for Markers and Subclips
• Adding Markers
• Subclips
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Searching for Markers and Subclips
The ANNOTATE tab gives you an overview of the markers and subclips. In the ANNOTATE tab you can search, 
sort, and mark completed markers and subclips.

Figure 7.1  ANNOTATE Tab

To search for markers and subclips

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. In the top right panel, click the ANNOTATE tab.

The ANNOTATE tab opens.

5. In the Search box, enter a word or part of a word o search for assets by name or markers and subclips by 
description.

The ANNOTATE tab displays the assets, markers, and subclips retrieved by your search.
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6. To search by type, complete the following steps:

a. In the Search box, click the  Filter icon.

The Quick Filters dialog box opens.

b. Select the type of object to retrieve with your entered search.

The ANNOTATE tab updates to display the objects that match your entered search and selected type.

Adding Markers
Markers enable you to add information to points along the timeline of an asset.

To add a marker to an asset

1. Open the asset to add makers to in the Video Player screen.

2. Play or drag the playhead to the position in the clip to mark.

You can use the following keyboard shortcuts to navigate through a clip:

• J — backwards play. Play speed varies with the number of times the key is pressed.
• K — pause.
• L — forwards play. Play speed varies with the number of times the key is pressed.

3. Click the  Marker icon or press the P key.

The Create Marker dialog box opens.
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4. In the Name box, enter a name for the marker.

5. In the Description box, enter a description of the marker.

6. Click Create.

Xchange adds your new marker to the ANNOTATE tab.

Adding More Information
Users that have access to the Information option can view or modify the metadata attached to a marker. The 
Information option also enables you to add comments to a maker.

To use the Information option

1. In the ANNOTATION tab, select the maker to view metadata or add comments.

2. Click the  Information icon associated with the marker.

The Information dialog opens for the maker.



Streamline User Guide (v6.9) Markers and Subclips • 7–5

3. Click Metadata to view and modify marker metadata.

The Metadata section expands to display the metadata associated with the marker. The fields and status will 
vary as they are customizable.

4. To add a comment to the maker, complete the following steps:

a. In the Add a comment box at the bottom of the dialog box, enter a comment to add to the marker.

b. Click Send.

The Comments section display your comment.

5. To reply to a comments made by other users, complete the following steps:

a. Select the comment to which you want to send a replay.

b. Click the  Reply icon associated with the comment.

c. In the Reply box, enter your reply.

d. Click Send.

The Comments section displays your reply.

6. To edit a comment, complete the following steps:

a. Select the comment to edit.

b. Click the  Edit icon associated with the comment.

A blue border highlights the comment to indicate that your can edit the comment.
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c. Edit the comment as required.

d. Click Send.

The Comments section displays the updated comment.

7. To delete a comment, complete the following steps:

a. Select the comment to delete.

b. Click the  Delete icon associated with the comment.

An Alert opens.

c. Click Ok to delete the comment.

Xchange deletes the selected comment from the Comments section.

Managing Markers
You can change the location of a marker on the timeline or delete the marker from the timeline.

To manager makers on the timeline

1. To reposition a maker, complete the following steps:

a. In the ANNOTATION tab, select the maker to reposition on the timeline.

b. Click the  Position icon associated with the marker.

Xchange highlights the selected marker on the timeline.

c. On the timeline, click and drag the  highlighted marker to a new position.

d. Release the mouse button.

Xchange places the maker at the selected location.

e. Click the  Reset In / Out icon below the maker.

Xchange saves the new maker position.

2. To delete a marker from the timeline, complete the following steps:

a. In the ANNOTATION tab, select the maker to delete from the timeline.

b. Click the  Delete icon associated with the marker.

An Alert opens.

c. Click Ok to delete the maker.

Xchange deletes the selected marker from the ANNOTATION tab and the timeline.
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Subclips
Subclips identify smaller segments of an asset. You can user to break large clips into smaller and easier to handle 
pieces. A Subclip is made up of reference points to the source media. When you create a subclip, no additional 
media is replicated.

 Deleting the asset that a subclip references removes the subclip content and renders the subclip empty.

To create a subclip

1. Open the asset of which to create a subclip in the Video Player screen.

2. Play or drag the playhead to the start position for the subclip.

3. Click the  Marker icon or press the i key.

4. Play or drag the playhead to the end position for the subclip.

5. Click the  Subclip icon or press the S key to create a subclip with the set In and Out Points.

The Create Subclip dialog box opens.

6. In the Name box, enter a name for the subclip.

7. In the Description box, enter a description of the subclip.

8. Click Create.

Xchange adds the subclip to the ANNOTATE tab and the Video Player screen highlights the subclip on the 
timeline.
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Adding More Information
Users that have access to the Information option can view or modify the metadata attached to a subclip. The 
Information option also enables you to add comments to a subclip.

To use the Information option

1. In the ANNOTATION tab, select the subclip to view metadata or add comments.

2. Click the  Information icon associated with the subclip.

The Information dialog opens for the subclip.

3. Click Metadata to view and modify subclip metadata.

The Metadata section expands to display the metadata associated with the subclip. The fields and status will 
vary as they are customizable.
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4. To add a comment to the subclip, complete the following steps:

a. In the Add a comment box at the bottom of the dialog box, enter a comment to add to the subclip.

b. Click Send.

The Comments section display your comment.

5. To reply to a comments made by other users, complete the following steps:

a. Select the comment to which you want to send a replay.

b. Click the  Reply icon associated with the comment.

c. In the Reply box, enter your reply.

d. Click Send.

The Comments section displays your reply.

6. To edit a comment, complete the following steps:

a. Select the comment to edit.

b. Click the  Edit icon associated with the comment.

A blue border highlights the comment to indicate that your can edit the comment.

c. Edit the comment as required.

d. Click Send.

The Comments section displays the updated comment.

7. To delete a comment, complete the following steps:

a. Select the comment to delete.

b. Click the  Delete icon associated with the comment.

An Alert opens.

c. Click Ok to delete the comment.

Xchange deletes the selected comment from the Comments section.
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Managing Subclips
You can reposition a subclip on the timeline or delete the subclip from the timeline.

To manager subclips on the timeline

1. To reposition subclip, complete the following steps:

a. In the ANNOTATION tab, select the subclip to reposition on the timeline.

b. Click the  Position icon associated with the subclip.

Xchange highlights the selected subclip on the timeline.

c. On the timeline, click and drag the  start of the subclip to a new position.

d. Release the mouse button.

Xchange places the subclip start at the selected location.

e. Click the  Reset In / Out icon below the maker.

Xchange saves the new subclip start position.

f. On the timeline, click and drag the  end of the subclip to a new position.

g. Release the mouse button.

Xchange places the subclip end at the selected location.

h. Click the  Reset In / Out icon below the maker.

Xchange saves the new subclip end position.

2. To delete a subclip from the timeline, complete the following steps:

a. In the ANNOTATION tab, select the subclip to delete from the timeline.

b. Click the  Delete icon associated with the subclip.

An Alert opens.

c. Click Ok to delete the subclip.

Xchange deletes the selected subclip from the ANNOTATION tab and the timeline.
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Attaching Associated Files
Along with metadata and comments, you can also attach a file to an asset. Attaching files to assets is a good method 
of storing related documentation with an asset.

This chapter discusses the following topic:

• Attaching Files to Assets
• Managing Attached Files
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Attaching Files to Assets
The FILES tab in the INFO tab enables you to attach a file to an asset and manage the files attached to an asset.

 You can only attach one file to an asset.

To attach a file to an asset

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. Navigate to and select that asset to attach one or more files.

5. In the top right panel, click the INFO tab.

The INFO tab opens.

6. In the INFO tab, click the FILES tab.

The FILES tab opens.

7. Use one of the following methods to select the file to attach to the asset:

• Drag & Drop — drag a file from a storage location into the Drag & Drop File area.
• Browse — click Browse in the Drag & Drop File area to use a file browser to select the file to upload.

8. In the Drag & Drop Files area, click Upload.

Xchange attaches the selected file to the asset and lists the file in the FILES tab.

Managing Attached Files
You can change download the file attached to an asset or delete the attached file from the asset. When you want to 
attach a different file to an asset you must first delete the existing attached file from the asset.

To manager files attached to assets

1. Navigate to and select that asset to attach one or more files.

2. In the top right panel, click the INFO tab.

The INFO tab opens.
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3. In the INFO tab, click the FILES tab.

The FILES tab opens.

4. To download the attached file to your computer, click the  Download icon to the left of the file name.

Xchange downloads the attached file to your computer.

5. To delete the attached file from the asset, click the  Delete icon to the left of the file name.

Xchange deletes the file from the asset and removes it from the FILES tab.
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Streamline Xchange Library
The Streamline Xchange Library provides users a personal area within Streamline Xchange to sort, organize, and 
share assets.

This chapter discusses the following topic:

• Accessing the Streamline Xchange Library
• Adding Folders
• Sharing Folder Contents
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Accessing the Streamline Xchange Library
The My Media folder in the Library window automatically receives all assets uploaded by a user.

To access the Xchange Library

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. In the Menu Sidebar, click th e Browse tab.

The Browse tab opens.

The LIBRAY section contains your My Media folder. Any assets that you upload through the UPLOAD 
MANAGER are automatically added to your My Media folder. Since only specific users upload media file, 
and often times through the Streamline Xchange Premiere Panel, you may find that your My Media folder is 
empty.

Adding Folders
You can add folders to your Library panel to help you manage assets.

To add folders to your Library

1. In the Library section, click the  Add icon at the bottom of the section.

The Add Folder to Library dialog box opens.

2. In the Folder Name box, enter a name for the folder.
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3. Click Create.

Xchange adds your new folder to the Library section.

4. You can now drag assets into your new folder from your My Media folder or from the Xchange Results panel.

5. Select your new folder to view the folder contents in the Xchange Results panel.

Sharing Folder Contents
After creating folders and adding assets to them, you can share your folders and their contents with other Xchange 
users.

 If one of the users that has access to a shared folder deletes it, or any contents inside the folder, all users sharing 
that folder will lose the deleted folder of folder content. The contents remain in Xchange but the library can no 
longer access the link. Only user with delete privileges can delete library folders or assets Xchange.

To share your folder contents with other users

1. In the Library section, select the folder to share with other users.

2. Click the  Settings icon in the upper right corner of the Library section.

The Edit User Bin dialog box opens.

3. Click ACCESS.

The ACCESS tab opens

4. Use the Groups list to select the user groups that can access the selected folder.

5. Use the Users list to select the users that can access the selected folder.

6. Click Save.

Xchange adds the folder to the Shared Location Library. The selected user groups and users will have access 
to the selected folder the next time the log in to Xchange.
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System Monitor
The Xchange System Monitor screen enables you to monitor the status of Xchange. This tool is diagnostic only, and 
does not contain any adjustment settings.

This chapter discusses the following topic:

• Viewing the System Monitor
• Changing Update Frequency
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Viewing the System Monitor
The System Monitor screen enables you to watch or monitor the status of Xchange.

To view the System Monitor

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. From the main menubar, click System Monitor.

The System Monitor screen opens.

The Summary section along the top of the System Monitor screen displays the following information:

• Users — the number of users currently logged in to Xchange.
• Uploads — the number of assets actively coming into Xchange.
• Queue — the number of assets waiting to initiate proxy rendering. 
• Create Proxy — the number of assets currently creating proxy files. As the number of assets in the Queue 

decreases, the number of assets in Create Proxy increases.
• Media Items — the number of assets registered in Xchange. High resolution assets and their associated low 

resolution proxy files count as one media item in Xchange.
• Markers — the number of markers placed on Xchange clips.
• Subclips — the number of subclips defined in Xchange clips.
• Deletion — the number of items pending permanent deletion from Xchange. Only administrators can trigger 

and execute permanent deletion of media or assets.
• Errors — the number of current issues within Xchange.
• Refresh — the number of seconds before the next refresh of the System Monitor page.

The Functions table below the Summary section displays information about specific Xchange functions.
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Changing Update Frequency
You can use the Refresh Rate section in the Tools tab to control the time period between information refreshes of 
the System Monitor screen.

To set the refresh rate for the System Monitor screen

1. In the right panel of the System Monitor screen, click the Tools tab.

The Tools tab opens.

2. In the Refresh Rate section, use the list to select the amount of time to wait between information refreshes of 
the System Monitor screen.

 The LIBRAY section contains your My Media folder. Any assets that you upload through the UPLOAD 
MANAGER are automatically added to your My Media folder. Since only specific users upload media file, 
and often times through the Xchange Premiere Panel, you may find that your My Media folder is empty.
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Project Dashboard
The Xchange Project Dashboard screen enables you to view the project activity in Xchange. You can also use the 
Project Dashboard screen to create, edit, or delete projects.

This chapter discusses the following topic:

• Viewing the Project Dashboard
• Creating New Projects
• Inspecting Projects
• Deleting Projects
• Searching for Projects
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Viewing the Project Dashboard
The Project Dashboard screen enables you to view the project activity in Xchange.

To view the System Monitor

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. From the main menubar, click Project Dashboard.

The Project Dashboard screen opens displaying information about the projects in your Xchange system.

5. To change the amount of time to wait between information refreshes of the Project Dashboard screen, 
complete the following steps:

a. In the upper right corner of the Project Dashboard screen, click Refresh In.

The Refresh menu opens.

b. Select the number of seconds to wait between information refreshes of the Project Dashboard screen. 
Select Stop Refresh to stop refreshing information in the Project Dashboard screen.
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6. To change the Project Dashboard screen view to the Informative view, click the  Informative icon.

The Project Dashboard screen changes to the Informative view and displays projects by status, quantity, and 
percentage.

7. To change the Project Dashboard screen view to the Global view, click the  Global icon.

The Project Dashboard screen changes to the Global view and displays projects by status, quantity, and 
percentage.

8. Use the Sort menu to select how project information is sorted in the Project Dashboard screen.

9. The Visible Projects number displayed between the Refresh In and SORT menus displays the number of 
projects that the Project Dashboard is currently displaying out of the total number projects in your Xchange 
system.
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Creating New Projects
You can also use the Project Dashboard screen to create new projects.

To create a new project from the Project Dashboard

1. At the top of the Project Dashboard screen, click Create Project.

The Create Project dialog box opens.

2. In the Project box, enter a name for the project.

3. Use the Destination list to select the storage destination for the project.

4. Use the Form list to select the form to add more information about the project.

Forms and permissions are customizable, each user or group can see the available forms and fields according to 
the requirements.

5. Enter information to complete the selected form.

6. Click Create Project.

Xchange adds the new project to the Project Dashboard screen.

Inspecting Projects
You can inspect a project to view and modify the metadata attached to the project. Inspecting a project gives you a 
view of the current status and progress of the project. You can also control user and group access permission to the 
project.

To inspect a project

1. In the Project Dashboard, use the  Settings menu associated with the project to inspect to select Inspect.

The Project Inspection dialog box opens for the selected project.

The Metadata tab displays the metadata attached to the project.
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2. To view user and group permissions set for the project, click the Permission tab.

The Permission tab opens.

3. Use the Access box to select users or groups to access the project.

4. To remove access permission from a user or group, click the X associated with the user or group from which 
to remove access permission.

Deleting Projects
When you delete a project you can choose to delete just the project, just the media, or both.

To delete a project

1. In the Project Dashboard, use the  Settings menu associated with the project to delete to select Delete.

The Delete Project dialog box opens.

2. Select the option that suits the amount of project data you want to delete.

You can choose to delete just the project, just the media, or both.

3. Click Delete Project.

An Alert opens.

4. Click Agree to delete the selected project. Click Cancel to keep the selected project.
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Searching for Projects
You can use the Search box in the Project Dashboard to focus the projects displayed in the Project Dashboard.

To search for projects in the Project Dashboard

1. In the Search box, enter a word or part of a word contained in the name of the projects to retrieve.

The Project Dashboard updates to display only the projects with names that contain the text entered in the 
Search box.

2. To once again view all available projects, click the  Clear icon in the Search box.

The Project Dashboard updates to display all available projects.
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Adding Users and Groups
Users and groups are set up within Xchange to determine permissions to specific modules and assets. Module and 
asset permissions are usually set up for groups. Users can subscribe to a group to inherit the permissions set for the 
group. Some permissions can be set at both the group and user level.

This chapter discusses the following topic:

• Creating New Users
• Creating New Groups
• Group Settings
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Creating New Users
You must create a user for each person in your organization that need to work on your Xchange system. An 
Xchange user enables a person to log on to the Xchange system and it controls their permissions on the system.

To create a new user

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. From the main menubar, click Configs.

The Configs screen opens.

5. In the panel on the left hand side of the screen, click Users.

The Config screen displays a list of Xchange system users. For each user the list displays user name, last login 
date, and login location (IP address).

To view the users currently logged in to your Xchange system, select the Logged in Users check box.

6. Click + in the lower left corner of the screen.

The Create New User dialog box opens.

7. In the First Name box, enter the first or proper name of the user.

8. In the Last Name box, enter the last or family name of the user.

9. If the user is allowed to log in to the Workflow Server connected to the Xchange system, enter their Workflow 
user name in the Workflow Username box.

10. In the Email box, enter the corporate e-mail address of the user.

11. Use the User Type to select Admin, Manager, or Standard as the user’s type.

Based on their type, a user may have more or less options while working in the Xchange system.

12. In the Password box, enter a initial password for the user. All new users should have and initial password.

After a user logs in to Xchange they can change their password. Passwords are case sensitive.

13. Click Create.

Xchange adds the new user to the Users list.
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Creating New Groups
Module and asset permissions are usually set up for groups. Users can subscribe to a group to inherit the 
permissions set for the group. Some permissions can be set at both the group and user level.

 Never delete the xchangeadmin group, it is used for configuration purposes!

To create a new group

1. In the panel on the left hand side of the Config screen, click Groups.

The Config screen displays a list of Xchange system groups.

In the Search box at the top of the Groups list, enter a word or part of a word contained in name of the groups 
to retrieve. If the Groups list is too long for the Config screen to display, click Load More to display the next 
page of groups.

2. Click + in the lower left corner of the screen.

The Create New Group dialog box opens.

3. In the Group Name box, enter a name for the group.

4. In the Description box, enter a description of the group.

5. Click Create.

Xchange adds the new group to the Groups list.

Group Settings
After you create a group, refer to the following section to apply group settings:

• General on page 12–4 — sets general setting for the group subscribers.
• Users on page 12–4 — subscribes users to the group.
• Modules on page 12–4 — sets the modules that group subscribers can access.
• Forms on page 12–5 — sets the forms and the default form used by group subscribers.
• Smart Bins on page 12–5 — sets the smart bins that group subscribers can access.
• Destinations on page 12–5 — sets the destinations and the default destination that group subscribers are allowed 

to use.
• Workflow Server Actions on page 12–6 — defines that actions exposed to group subscribers.
• Render Profiles on page 12–6 — sets the render profiles that group subscribers are allowed to use.
• Workspaces on page 12–6 — sets workspaces and the default workspace for group subscribers.
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General
New groups have no General settings selected. If you are not sure of the General settings to selected for your new 
group, check the Generals settings selected for an existing group.

Select the check box associated with a General setting to select it for your group. Clear the check box associated 
with as setting to remove it from the group. The available General settings are as follows:

Figure 12.1  General Settings

Users
To select the users that subscribe to a group, select the check boxes associated with the users the you want to 
subscribe to the group. Clear the check box associated with a user to unsubscribe the user for the group. An example 
Users list looks as follows:

Figure 12.2  Example Users List

To view the users already subscribe to a group, select the In Group Only check box.

Modules 
Use Modules to define which functionality available to the users subscribed to the group. Select the check boxes 
associated with the modules that subscribed users can access. Clear the check box associated with a module to 
remove group access from the module. The available modules are as follows:

Figure 12.3  Modules
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Forms
Forms are used to display metadata. Various forms can be created to display metadata for different purposes. 
Multiple forms can contain the same metadata field.

There are different forms for media, projects, and Elastic Data Viewer (EDV). Select the check boxes associated 
with the forms to which subscribed users require access. Clear the check box associated with a form to remove 
group access from the form. A default forms can be set up for the Xchange Media Info and Registration sections. 
An example Forms list looks as follows:

Figure 12.4  Example Forms List

Smart Bins
Smart bins are filtered collections of assets. If a group does not have access to assets (for example through a smart 
bin) asset will not show up in searches. Select the check boxes associated with the smart bins to which subscribed 
users require access. Clear the check box associated with a smart bin to remove group access from the smart bin. An 
example smart bin list looks as follows:

Figure 12.5  Example Smart Bins List

 Smart bins can also have sub bins. Granting access to the parent smart bin does not grant access to the underlying 
Sub Bins. You must also grant group access to Sub Bins if required.

Destinations
An installation can consist of multiple Xchange and other MAM instances.

Use the MAM Servers list to select the destinations the subscribed users can access. Select the check boxes 
associated with the destinations to which subscribed users require access. Clear the check box associated with a 
destination to remove group access from the destination. An example Destinations list looks as follows:

Figure 12.6  Example MAM List

Xchange is also capable of publishing to several social media instances, with appropriate licenses. Use the Social 
Servers list to select the social servers to which subscribed users can publish content. Select the check boxes 
associated with the social servers to which subscribed users require publishing access. Clear the check box 
associated with a social server to remove group access from the social server. An example Social Servers list looks 
as follows:

Figure 12.7  Example Social Servers List
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Workflow Server Actions
Xchange uses the Workflow Server platform to execute scripts. Use this list to select the actions on the Workflow 
Server that are available to subscribed users. Select the check boxes associated with the actions to which subscribed 
users require access. Clear the check box associated with an action to remove group access from the action. 

Render Profiles 
Xchange uses different settings to create proxies for streaming, download, and others.

The available settings depend on the configuration of the Xchange platform. You can implement more than one 
Proxy quality for Streaming, Download, and others. Use this list to enable subscribed users to stream, download, 
and publish specific asset qualities,

Select the Default check box to set the associated profile as the default profile for subscribed users. Select the 
Re-Render check box enables subscribed users initiate a render job to create or re-create a proxy. 

Figure 12.8  

If you are not sure which check boxes to select, please use an existing group as a template.

Workspaces
If you have defined multiple workspaces on your Xchange system, you can grant subscribed users access to one or 
more workspaces. Select the check boxes associated with the workspaces to which to grant subscribed users access. 
Clear the check box associated with a workspace to remove group access from the workspace. Select the Default 
option associated with the workspace that you want to be the default workspace for the subscribed users. An 
example Workspaces list looks as follows:

Figure 12.9  Example Workspaces List
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Smart Bins
Smart bins use filters to control the assets that they store. All users can create normal bins. Only administrators or 
users with the appropriate permissions can create smart bins.

This chapter discusses the following topic:

• Creating New Smart Bins
• Setting Smartbin Filters
• Allowing Smart Bin Access
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Creating New Smart Bins
Only administrators or users with the appropriate permissions can create smart bins.

To create a new Smart Bin

1. Use a supported browser to open the Streamline Xchange web interface provided by your Streamline Xchange 
administrator:

The Login screen opens.

2. In the Login screen, enter your Streamline Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Streamline Xchange opens.

4. From the main menubar, click Configs.

The Configs screen opens.

5. In the panel on the left hand side of the screen, click Smartbins.

The Config screen displays a list of the available Smart Bins on your Streamline Xchange system.

6. Click the + button in the lower left corner of the screen.

The Create Smartbin dialog box opens.

7. In the Create Smartbin dialog, enter the following:

› Bin Name* — Enter a meaningful name for the smart bin. This field is required, but can be edited after 
creation if necessary.

› Parent Bin — Select the existing bin that you wish the smart bin to be added to.
Note: If a parent bin is selected in the tree view prior to clicking the + button then it will be preselected.

› Target Projects — If this button is enabled, this smart bin will only display projects that match the configured 
filters. If this button is disabled (default), this smart bin will only display assets that match the configured 
filters.

8. Click Create.

Streamline Xchange will create your new smart bin in the selected parent bin.

9. To add filters to control which assets will be stored in your smart bin, see:

› “To set a filter for a Smart Bin” on page 13–3

 IMPORTANT: 

You must also go to the Groups and/or Users lists to select who will have access to the newly created smart bin. 
If you do not grant access then the Smart Bin will not be visible to users.
› See, “To Allow Groups or Users Access to the Smart Bin” on page 13–4
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Setting Smartbin Filters
Smartbins use filters to control the assets that they store. The right hand side of the screen lists the available 
metadata fields that can be used to set Smart Bin filters.

To set a filter for a Smart Bin

1. Drag and drop metadata fields from the Metadata Fields list to the middle area of the screen.

2. If the Metadata Fields list does not display the field your require, try using the Search Filters box at the top of 
the list to find the field.

Use the Operators list to determine the filter criteria for the selected metadata field.

The filter criteria Is and Is Not are absolute, if the criteria are not completely met, the result is false. The filter 
criteria Like and Not Like allow for partial matching within the Search string. The extra criteria in the last 
column are Start, Ends, and Any Part.

It is possible to stack different filters and build a series of filters within the Smart Bin. All filter results must be 
true in order for an asset to show up inside a Smart Bin.

3. You must proceed to make the new smart bin available to users or user groups:

› “To Allow Groups or Users Access to the Smart Bin” on page 13–4

Allowing Smart Bin Access
After creating a smart bin, it is important to grant access to the appropriate users or groups. Access can be assigned 
either during smart bin creation or afterwards.

Figure 13.1  Groups and User Access

 IMPORTANT:
Smart bins may include sub bins. Granting access to a parent smart bin does not automatically grant access to its 
sub bins. If access to a sub bin in is required, permissions must be set separately for each one.



13–4 • Smart Bins Streamline User Guide (v6.9)

To Allow Groups or Users Access to the Smart Bin

1. To grant access to Groups or Users, go to Config > Smartbin, and select the Smartbin you wish to edit.

2. Go to the Groups panel and/or User panel on the right side, and select all of the Groups or Users you wish to 
have access to the Smartbin.

3. To verify that the permissions have been applied, log out of Streamline Xchange, and log in as one of the users 
you granted access to. Confirm that the smart bin is available in the Xplore > Browse tab under the Smartbin 
panel.

To Modify Access to Existing Smart Bins

1. Navigate to Xplore > Browse panel.

2. In the Smartbin panel, select the desired smart bin.

3. Click the ellipsis  button.

4. In the Smartbin Access dialog, select or de-select the appropriate Groups and/or Users to control access.

 IMPORTANT: 

Remember that you must repeat this action to set permissions for each individual sub bin within a parent bin.
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Metadata and Forms
Metadata is important to enable fast searching and clear categorizing of assets within your Xchange system. Forms 
organize the display of metadata fields and enable a better overview of metadata fields assigned to assets. 

This chapter discusses the following topic:

• Creating New Forms
• Adding Individual Metadata Fields
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Creating New Forms
After you create a form you can add metadata fields to the form.

To create a new form

1. Use an HTML5 web browsers to open the Xchange web page provided by your Xchange administrator:

The Login screen opens.

2. In the Login screen, enter your Xchange login credentials in the Username and Password boxes.

3. Click Sign In.

Xchange opens.

4. From the main menubar, click Configs.

The Configs screen opens.

5. In the panel on the left hand side of the screen, click Metadata.

The Config screen displays a list of the available forms on your Xchange system, one for media and one for 
projects.

6. Click + in the lower left corner of the screen.

The Media Form dialog box opens.

7. In the Form Name box, enter a name for the form.

8. Use the Metadata Field list to select a metadata field to add to the new form.

When adding metadata fields to a form, there are several options you can set for that field. You can add 
metadata fields from the list on the right hand side by dragging and dropping these into the middle section of 
the Xchange screen.

When importing metadata from other systems, metadata fields that are not in your Xchange system will be 
automatically populated. Automatically populated metadata fields are not on a form by default.

Options
The following options are valid for the form only and can be different between individual forms:

Figure 14.1  Form Options

• Line — use this list to select the number of lines that to display.
• Read-Write or Read Only — use this list to select if the metadata field value can be modified or if it is 

read-only.
• Not Required or Required — use this list to select if the metadata field value is mandatory or not. 
• No Typing or Allow Typing — use this list to select if a user can enter free text in a metadata field or if they can 

only select from predefined values.
• No Multiple or Allow Multiple — use this list to select if a a user can select one or multiple predefined values.
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Predefined Values
In particular cases, it may be wise only to create pre-defined values for a metadata field. 

Figure 14.2  Form Predefined Values

Enter the desired predefined values in the Predefined Values field, separated by commas. By selecting No Typing 
in the Option section, users must select a value for the metadata field from the set predefined values.

Adding Individual Metadata Fields
You can also add individual metadata fields to a form.

 In order to use your added fields, you must place the fields on a form.

To add individual metadata fields to a form

1. Click + in the lower left corner of the screen.

The Create Metadata Field dialog box opens.

2. In the Field Name box, enter a name for the field.

3. Use the Field Type list to select whether the field is a Text, Date, Flag, or Time field.

4. Select the In Adv Search check box to incorporate the field in advanced searches.

5. Select the In Simple Search check box to incorporate the field in simple searches.

6. Select the Sortable check box to enable the value of the field to be used for sorting.

7. Click Create Field.

 Xchange creates the defined metadata field.
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Video Editor
If your MAM workflow includes the Ross Video Streamline Pro media asset manager, and your organization has 
purchased the Streamline Pro Video Editor license, then you can use the Streamline Xchange Video Editor tab to 
quickly access the Streamline Pro Video Editor web interface. 

 For more details, please see the Streamline Pro Web Video Editor User Guide v6.9.

This chapter discusses the following topic:

• Starting the Video Editor
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Starting the Video Editor
You can open the Streamline Pro Web Video Editor from the Streamline Xchange MAM user interface.

 NOTE: If you do not see a Video Editor tab in your Streamline Xchange expanded menu, please contact your 
system administrator. An enabled Streamline Pro Video Editor license is required.

To open the Streamline Pro Web Video Editor

1. Use one of the following supported web browsers to open the Streamline Xchange Web Editor provided by 
your Streamline administrator: 

› Google Chrome™ 126.0 and later
› Apple Safari® 17.4.1 and later

The Streamline Xchange Sign In page opens.

2. Enter your Streamline Xchange credentials in the Username and Password boxes.

3. From the top menu of Streamline Xchange, to expand the menu select the  button.

4. Select Video Editor to launch the Streamline Pro Web Video Editor.

The Streamline Pro Web Video Editor opens in a new Tab.

5. Bookmark the Streamline Pro Web Video Editor page in your web browser.
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 For your security, Streamline automatically logs you out after 30 minutes of inactivity. If you sign in from 
another device or browser tab, this session will automatically log you out.

To close the Streamline Pro Video Editor

1. In Streamline Pro tab, click the close icon  to end the Streamline Pro Video Editor web session.

2. Go to the Streamline Xchange Xchange - Xplore tab, from the expanded menu click Logout.
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